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Introduction 
The Utilities / Import / ASCII File command in Creative Solutions Accounting™ (CSA) is provided to 
import ASCII data files into Write-Up CS™ or Trial Balance CS™ within CSA and the CS Professional 
Suite® Accounting Products software.  

This import guide explains the file layout information required by CSA to import your data from ASCII text 
files into Write-Up CS, as well as the necessary procedures to import the data files. 

Important! If you intend to prepare your ASCII data using Microsoft® Excel,® please refer to the PDF 
guide called “Checklist for Importing ASCII Client Data into CSA using Microsoft Excel.” 

Import command overview 
The overall objective of the Utilities / Import / ASCII File command in Creative Solutions Accounting is to 
provide a time-saving way to import data from non-CS Professional Suite programs to CSA. All import 
files must be structured according to the specifications in this guide. Although importing information can 
save time over reentering the data into CSA, the structuring of the import files is technical in nature and 
may be time-consuming. 

The Utilities / Import / ASCII File command in CSA can import four types of data into Write-Up CS: 

 GL accounts with balances. 

 GL transactions for the current year. 

 Employee general information, current-period earnings, current-quarter earnings, and year-to-date 
earnings. 

 Vendor general information and the year-to-date amount paid. 

This document explains the necessary structure of the import files in detail. Note that the Utilities / Import / 
ASCII File command in CSA recognizes only fixed-length ASCII import files. Variable-length ASCII or 
DBF files cannot be imported into CSA. 

http://cs.thomsonreuters.com/ua/acct_pr/csa/cs_us_en/pdfs/checklist_for_importing_ascii_data_with_excel.pdf
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Filenaming guidelines 
This section describes the filenaming conventions that must be followed when preparing the ASCII files 
for import. 

General requirements for filenames 
 Filenames are limited to 8 significant characters plus a 3-character extension. 

 Long filenames are not permitted. 

 The filenames can contain only numeric values (0-9) and the letters A-Z. 

 For all files created for a particular client, you should use the same 5 significant characters as part of 
the filename. 

General ledger accounts file 
The filename format should be Gxxxxx.GLA. Only one general ledger account file should be created per 
client. 

 The “G” must be the first character of the filename. 

 The “xxxxx” represents the five characters of the client ID. These five characters do not necessarily 
need to match the client ID used in CSA. The “xxxxx” is used to identify the files when you import 
them. 

 The filename extension “GLA” should always be used to designate the general ledger account file. 

General ledger transaction files 
The filename format should be Gxxxxxyn.GLT. Up to 13 general ledger transaction files can be created 
for each client. Each processing period must have its own general ledger transaction file. 

 The “G” must be the first character of the filename. 

 The “xxxxx” represents the five characters of the client ID. These five characters do not necessarily 
need to match the client ID used in CSA. The “xxxxx” is used to identify the client files as you go 
through the import process. 

 The “y” represents the alphabetical code for the period the transactions apply to. Code A is always 
used for January, Code L is always used for December, and so on, regardless of the fiscal year end 
date. 

 The “n” is used to identify 13-period client files. If the client is not a 13-period processor, this position 
in the filename should always contain a zero. For 13-period processors, if the period end date is 
between the 1st and 15th of the month, a zero should be entered in this position. If the period end date 
is between the 16th and the 31st of the month, a “1” should be used in this position. 

 The filename extension “GLT” should always be used to designate general ledger transaction files. 

Vendor file 
The filename format should be Gxxxxx.VEN. Only one vendor file should be created per client. 

 The “G” must be the first character of the filename. 
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 The “xxxxx” represents the five characters of the client ID. These five characters do not necessarily 
need to match the client ID used in CSA. The “xxxxx” is used to identify the files when you import 
them. 

 The filename extension “VEN” should always be used to designate the vendor file. 

Employee file 
The filename format should be Gxxxxx.PRR. Only one employee file should be created per client. 

 The “G” must be the first character of the filename. 

 The “xxxxx” represents the five characters of the client ID. These five characters do not necessarily 
need to match the client ID used in CSA. The “xxxxx” is used to identify the files when you import 
them. 

 The filename extension “PRR” should always be used to designate the employee file. 

General guidelines for amount and text fields 
This section describes the general formatting requirements for amount fields and text fields. Each field 
allowed in the import file falls into one of these types. (The comments column of the tables that follow 
indicates whether the field should follow the requirements for text or for amounts.) 

General file requirements 
 All files must contain one record per line. A record is defined as one employee, one general ledger 

account, one general ledger transaction, and so on. 

 Each line should end with a carriage return/line feed. 

 A comma should delimit all fields within the import file. 

Amount field requirements 
 All amounts should be right-justified in the field. 

 All amounts in the file should be 12 digits long. 

 Only numerals (0-9) and a decimal point are allowed in amount fields (with the exception of a 
negative sign). Note that commas are not allowed in amount fields. 

 The use of a negative sign to denote a credit balance/amount is allowed. The use of a positive sign is 
not allowed in the import file. All payroll wage and withholding amounts should be entered as positive 
amounts. 

Text field requirements 
 All text fields should be enclosed in quotes, unless otherwise indicated in the “Comments and 

additional information” column of the following tables. Consecutive text fields may be enclosed in a 
single set of quotes, or quotes may be included around each field individually. 
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 All text fields have a fixed length, as noted in the following tables. All text fields should be left-
justified and padded with spaces to match the required field width, as described in the following 
tables. 

Items transferred during import of data 
The following tables are provided to identify fields that can be imported into Write-Up CS. The tables are 
organized in the exact order they should appear in the import file and denote the necessary screen 
navigation to the field in CSA. 

General ledger account import file specification 
All fields in the following table are in the exact order they should appear in the Gxxxxx.GLA file. 

Field description 
(Text or amount) 

Field 
Number 

Field  
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

 Setup / Chart of Accounts 

Account Number 
(Text) 

1 11 Acct # An account number can consist 
of up to 10 characters plus a 
decimal point (11 characters in 
all) with no more than 3 digits to 
the right of the decimal. See 
Import notes and exceptions. 

Account Type 
(Text) 

2 1 Type The account type is a one-
character field, as follows: 
A = Asset accounts 
L = Liabilities and Equity 
accounts 
R = Revenue accounts 
E = Expense accounts 

Description 
(Text) 

3 29 Description  

Current Year 
Beginning 
Balance 
(Amount) 

4 12 Balance  

Current Year  
Period 1-13 
Balance Changes 
(Amount) 

5-17 12 Balance Each of these 13 fields should 
contain the amounts representing 
the change for the period (not 
the actual ending balance). 

Prior Year  
Beginning 
Balance 
1 Year Ago 
(Amount) 

18 12 Balance  
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Field description 
(Text or amount) 

Field 
Number 

Field  
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Prior Year  
Period 1-13 
Balance Changes 
1 Year Ago 
(Amount) 

19-31 12 Balance Each of these 13 fields should 
contain the amounts representing 
the change for the period (not 
the actual ending balance). 

Budget Amounts 
Current Year Only 
(Amount) 

32-44 12 Budget  

Prior Year  
Beginning 
Balance 
2 Years Ago 
(Amount) 

45 12 Balance  

Prior Year  
Period 1-13 
Balance Changes 
2 Years Ago 
(Amount) 

46-58 12 Balance Each of these 13 fields should 
contain the amounts representing 
the change for the period (not 
the actual ending balance). 

Prior Year  
Beginning 
Balance 
3 Years Ago 
(Amount) 

59 12 Balance  

Prior Year  
Period 1-13 
Balance Changes 
3 Years Ago 
(Amount) 

60-72 12 Balance Each of these 13 fields should 
contain the amounts representing 
the change for the period (not 
the actual ending balance). 

Prior Year  
Beginning 
Balance 
4 Years Ago 
(Amount) 

73 12 Balance  

Prior Year  
Period 1-13 
Balance Changes 
4 Years Ago 
(Amount) 

74-86 12 Balance Each of these 13 fields should 
contain the amounts representing 
the change for the period (not 
the actual ending balance). 
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Field description 
(Text or amount) 

Field 
Number 

Field  
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Tax Line Code 
(Text) 

87 15 Tax Code For information about tax codes 
(which facilitate balance transfers 
to UltraTax CS™ or GoSystem® 
Tax), search on Tax code from 
the index of the CSA help 
browser. 

 

General ledger transaction import file specification 
All fields in the following table are in the exact order they should appear in the Gxxxxxyn.GLT file. 

Field description 
(Text or amount) 

Field 
Number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

 Tasks / Transactions Entry 

Reference 
(Text)  

1 6 Reference  The reference is 6 characters 
long and may contain 1 decimal. 

Transaction Date 
(Text) 

2 6 Date The formatting of dates should be 
MMDDYY and should not contain 
any “/” characters. See GL 
transactions — reference. 

Month 
(Text) 

3 2 [No navigation is 
available for this field. It 
is not displayed in CSA.] 

Indicate the period to which CSA 
should post the transaction. 
January is always 1 and 
December is always 12, 
regardless of the fiscal year end 
date. The Month field is used for 
reporting purposes only and does 
not determine the period to which 
the transaction is posted. 

Acct/Number 
(Text) 

4 11 Account Number An account number may consist 
of up to 10 characters plus a 
decimal point (11 characters in 
all), with no more than 3 
characters to the right of the 
decimal. See Import notes and 
exceptions. 

Description 
(Text) 

5 110 Description  

Transaction 
Amount 
(Amount) 

6 12 Amount  
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Employee import file specifications 
All fields in the following table are in the exact order they should appear in the Gxxxxx.PRR file. 

Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

 Setup / Employees / General tab 

Employee ID 
(Text) 

1 8 ID CSA accepts only the 
alphanumeric characters 0-9 and 
A-Z for the employee ID.  

First Name 
(Text) 

2 15 First  

Middle Initial 
(Text) 

3 1 MI   

Last Name 
(Text) 

4 20 Last   

Street Address 
(Text) 

5 30 Street  

City 
(Text) 

6 20 City  

State 
(Text) 

7 2 State  

Zip Code 
(Text) 

8 10 Zip The field length is 10 characters 
in CSA and should include 
formatting such as XXXXX-
XXXX. 

Social Security 
Number 
(Text) 

9 11 SSN/EIN The field length is 11 characters 
and should include formatting 
such as XXX-XX-XXXX. 

Area Code 
(Text) 

10 3 Phone Alpha characters such as A-Z are 
not allowed in this field. 

Phone Number 
(Text) 

11 8 Phone The field length is 8 characters 
and should include formatting 
such as XXX-XXXX. Alpha 
characters such as A-Z are not 
allowed in this field. 

 Setup / Employees / Tax Withholding and Deduction tab 

State Code 
(Text) 

12 2 State W/H Properties 
button 
State 

Numeric values (0-9) are not 
allowed in this field. 

Local Code 
(Text) 
 
 

13 2 Local W/H properties 
button 
Locality 

Numeric values (0-9) are not 
allowed in this field. 
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

  Setup / Employees / Other tab 

SUTA State 
(Text) 

14 2 SUTA GL Accounts 
State 

Numeric values (0-9) are not 
allowed in this field. 

 Setup / Employees / General tab 

Payroll 
Department 
(Text) 

15 3 Department Numeric values of 1-9 and alpha 
characters A-Z are accepted in 
this field. 
Zero is not a valid department 
number. If no department is 
available, default to a 1 in this 
field. 

  Setup / Employees / Earnings tab 

Current Period 
Hourly Wages 
(Amount) 

16 12 Wages  

Current Period 
Salaried Wages 
(Amount) 

17 12 Salaried Wages  

Current Period 
Overtime Wages 
(Amount) 

18 12 Overtime  

Current Period 
Commissions 
(Amount) 

19 12 Commissions  

Current Period 
Bonus 
(Amount) 

20 12 Bonus  

Current Period 
Sick Pay 
(Amount) 

21 12 Sick Pay  

Current Period 
Vacation/Holiday 
(Amount) 

22 12 Vacation  

Current Period 
Tips 
(Amount) 

23 12 Reported Tips  

Current Period 
EIC 
(Amount) 

24 12 EIC Advance  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Current Period 
Other Wage Items 
(Amount) 

25 12 Other Wages This field should contain all other 
wage amounts paid that are not 
specified above. 

 Setup / Employees / Tax Withholdings and Deductions 
tab 

Current Period 
FICA –SS 
Withheld 
(Amount) 

26 12 FICA-SS  

Current Period 
Medicare Withheld 
(Amount) 

27 12 FICA-Med  

Current Period 
Federal Withheld 
(Amount) 

28 12 Federal W/H  

Current Period 
State Withheld 
(Amount) 

29 12 State W/H  

Current Period 
Local Withheld 
(Amount) 

30 12 Local W/H  

Current Period 
401K 
Contributions 
(Amount) 

31 12 401K Fixed Amount  

Current Period 
Cafeteria Plan  
(Amount) 

32 12 Cafe Fixed Amount  

Current Period 
Loan Repayments 
(Amount) 

33 12 Loan Repayment  

Current Period 
Medical Insurance 
(Amount) 

34 12 Medical Insurance  

Current Period 
Life Insurance 
(Amount) 

35 12 Life Insurance  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Current Period 
Meals and 
Housing 
(Amount) 

36 12 Meals/Lodging  

Current Period 
Uniforms 
(Amount) 

37 12 Uniforms  

Current Period 
Union Dues 
(Amount) 

38 12 Union Dues  

 Setup / Employees / Direct Deposit tab 

Current Period 
Direct Deposit 
(Amount) 

39 12 Amount  

 Setup / Employees / Tax Withholdings and Deductions 
tab 

Current Period 
Other Withheld 
(Amount) 

40 12 Other Deductions This field should contain all other 
withheld amounts that are not 
specified above. 

 Setup / Employees / Earnings tab 

Current Quarter 
Hourly Wages 
(Amount) 

41 12 Wages  

Current Quarter 
Salaried Wages 
(Amount) 

42 12 Salaried Wages  

Current Quarter 
Overtime Wages 
(Amount) 

43 12 Overtime  

Current Quarter 
Commissions 
(Amount) 

44 12 Commissions  

Current Quarter 
Bonus 
(Amount) 

45 12 Bonus  

Current Quarter 
Sick Pay 
(Amount) 

46 12 Sick Pay  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Current Quarter 
Vacation/Holiday 
(Amount) 

47 12 Vacation  

Current Quarter 
Tips 
(Amount) 

48 12 Reported Tips  

Current Quarter 
EIC 
(Amount) 

49 12 EIC Advance  

Current Quarter 
Other Wage Items 
(Amount) 

50 12 Other Wages This field should contain all other 
wage amounts paid that are not 
specified above. 

 Setup / Employees / Tax Withholdings and Deductions 
tab 

Current Quarter 
FICA –SS 
Withheld 
(Amount) 

51 12 FICA-SS  

Current Quarter 
Medicare Withheld 
(Amount) 

52 12 FICA-Med  

Current Quarter 
Federal Withheld 
(Amount) 

53 12 Federal W/H  

Current Quarter 
State Withheld 
(Amount) 

54 12 State W/H  

Current Quarter 
Local Withheld 
(Amount) 

55 12 Local W/H  

Current Quarter 
401K 
Contributions 
(Amount) 

56 12 401K Fixed Amount  

Current Quarter 
Cafeteria Plan  
(Amount) 

57 12 Cafe Fixed Amount  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Current Quarter 
Loan Repayments 
(Amount) 

58 12 Loan Repayment  

Current Quarter 
Medical Insurance 
(Amount) 

59 12 Medical Insurance  

Current Quarter 
Life Insurance 
(Amount) 

60 12 Life Insurance  

Current Quarter 
Meals and 
Housing 
(Amount) 

61 12 Meals/Lodging  

Current Quarter 
Uniforms 
(Amount) 

62 12 Uniforms  

Current Quarter 
Union Dues 
(Amount) 

63 12 Union Dues  

 Setup / Employees / Direct Deposit tab 

Current Quarter 
Direct Deposit 
(Amount) 

64 12 Amount  

 Setup / Employees / Tax Withholdings and Deductions 
tab 

Current Quarter 
Other Withheld 
(Amount) 

65 12 Other Deductions This field should contain all other 
withheld amounts that are not 
specified above. 

 Setup / Employees / Earnings tab 

Year to Date 
Hourly Wages 
(Amount) 

66 12 Wages  

Year to Date 
Salaried Wages 
(Amount) 

67 12 Salaried Wages  

Year to Date 
Overtime Wages 
(Amount) 

68 12 Overtime  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Year to Date 
Commissions 
(Amount) 

69 12 Commissions  

Year to Date 
Bonus 
(Amount) 

70 12 Bonus  

Year to Date 
Sick Pay 
(Amount) 

71 12 Sick Pay  

Year to Date 
Vacation/Holiday 
(Amount) 

72 12 Vacation  

Year to Date 
Tips 
(Amount) 

73 12 Reported Tips  

Year to Date 
EIC 
(Amount) 

74 12 EIC Advance  

Year to Date 
Other Wage Items 
(Amount) 

75 12 Other Wages This field should contain all other 
wage amounts paid that are not 
specified above. 

 Setup / Employees / Tax Withholdings and Deductions 
tab 

Year to Date 
FICA –SS 
Withheld 
(Amount) 

76 12 FICA-SS  

Year to Date 
Medicare Withheld 
(Amount) 

77 12 FICA-Med  

Year to Date 
Federal Withheld 
(Amount) 

78 12 Federal W/H  

Year to Date 
State Withheld 
(Amount) 

79 12 State W/H  

Year to Date 
Local Withheld 
(Amount) 

80 12 Local W/H  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Year to Date 
401K 
Contributions 
(Amount) 

81 12 401K Fixed Amount  

Year to Date 
Cafeteria Plan  
(Amount) 

82 12 Cafe Fixed Amount  

Year to Date 
Loan Repayments 
(Amount) 

83 12 Loan Repayment  

Year to Date 
Medical Insurance 
(Amount) 

84 12 Medical Insurance  

Year to Date 
Life Insurance 
(Amount) 

85 12 Life Insurance  

Year to Date 
Meals and 
Housing 
(Amount) 

86 12 Meals/Lodging  

Year to Date 
Uniforms 
(Amount) 

87 12 Uniforms  

Year to Date 
Union Dues 
(Amount) 

88 12 Union Dues  

  Setup / Employees / Direct Deposit tab 

Year to Date 
Direct Deposit 
(Amount) 
 
 

89 12 Amount  

 
 

Setup / Employees / Tax Withholdings and Deductions 
tab 

Year to Date 
Other Withheld 
(Amount) 

90 12 Other Deductions This field should contain all other 
withheld amounts that are not 
specified above. 
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Vendor import file specifications 
All fields in the following table are in the exact order they should appear in the Gxxxxx.VEN file. 

Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

 Setup / Vendors / General tab 

Vendor ID 
(Text) 

1 11 Vendor ID  

Name 
(Text) 

2 36 Name  

Address Line 1 
(Text) 

3 40 Street  

Address Line 2 
(Text) 

4 40 Street  

City 
(Text) 

5 20 City  

State 
(Text) 

6 2 State  

Zip 
(Text) 

7 10 Zip The field length is 10 characters 
and should include formatting 
such as XXXXX-XXXX. 

Social Security # 
(Text) 

8 11 SS# The SSN is 11 characters 
including formatting such as XXX-
XX-XXXX. 

Area Code 
(Text) 

9 3 Phone The area code is 3 characters in 
length and should not contain any 
formatting such as brackets. 

Phone number 
(Text) 

10 8 Phone The field length is 8 characters in 
length and should contain 
formatting such as XXX-XXXX. 

Contact 
(Text) 

11 20 Contact  

Acct # with 
Vendor 
(Text) 

12 10 Account #  

 Setup / Vendors / Address and Accounts tab 

Default 
Description 
(Text) 

13 20 Check memo  
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Field description 
(Text or amount) 

Field 
number 

Field 
Width 

CSA menu navigation 
CSA field name 

Comments and additional 
information  

Amount 
(Amount) 

14 12 Year-to-date checks This amount represents the year-
to-date checks paid to the 
vendor. It does not break the 
amounts up into 1099 type. If 
there are multiple 1099 type 
payments, you will need to break 
this information apart in CSA after 
completing the import. 

 

Importing the files into CSA 
After creating the import files, use the following steps to import the data files into CSA. 

1. Start the CSA program by double-clicking the desktop icon for Creative Solutions Accounting. 

2. Create a new client in CSA by choosing New Client from the File menu. For more information on 
creating a new client, choose CSA Help Topics from the Help menu, then click the Index button and 
choose New Client [File menu].  

3. After creating a new client, choose Utilities / Import / ASCII File. 

4. Enter the location of the data files that you wish to import into CSA, or click the Browse button and 
navigate to the desired location. 

5. In the Client to import field, enter the company ID you want to import or press F4 and choose from 
the drop-down list of all companies available to import. 

6. If the client data files contain employee information and you want to convert the employee earnings 
totals, mark the Convert Employee Earnings checkbox. 

7. Click the Import button. 

8. After the import has been completed, you should make any necessary changes or corrections to the 
imported data. To check the accuracy of the imported data, run a current-period and year-to-date 
General Ledger Report and Transaction Listing from the File / Print dialog in CSA to verify the 
transactions. You should also print a Trial Balance Report to verify the Chart of Accounts and 
balances, as well as an Earnings Report to verify employee earnings. 

Import notes and exceptions 
The following section details all known import exceptions and issues to be aware of when structuring your 
import files. 

GL transactions — reference 
 Transactions that do not contain a reference cannot be imported to CSA. Each transaction must 

contain a reference, and all matching references are combined into a single transaction. 
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 CSA assumes that references that are numerals greater than 100 are check numbers. 

 If you are importing transactions that are a balance-to-cash entry, the reference must be the numeral 
1. 

Chart of Accounts mask 
The following information is important when structuring the import of account numbers in the general 
ledger balances and transactions files. 

 The following information is important when structuring the import of account numbers in the general 
ledger balances and transactions files. 

 CSA requires that department numbers be located to the left of the core account number. Therefore, 
if a client’s account mask is XXX.XXDD, where X is the core account number and D is the 
department, it should be structured in the file as a DDXXX.XX. Note that only the account numbers 
themselves are imported. CSA does not import the actual mask. The Chart of Account mask should 
be entered when you add each new client prior to importing the data file. 

 The import to CSA accepts as valid account characters letters, hyphens, and slashes, plus a decimal 
point. If a client’s Chart of Accounts contains characters other than letters, hyphens, slashes, and a 
decimal, you need to strip those from the account when structuring the import data file. For example, 
A30-553.10 is accepted as a valid account number during the import. However, A30_553.10 is not 
valid and would need to be amended in the import file. 

GL account number 00000 
CSA does not allow an account number of all zeros to be imported. If an account number consisting of all 
zeros exists in your client data, it should be renumbered to an accepted account number.  

CSA combining accounts 
CSA allows you to define “combining” accounts, which link individual department accounts and combine 
their amounts for reporting purposes. No transactions can be posted to the account and no balances 
need to be entered. These accounts are simply used to combine general balances for accounts that have 
already been posted to. If your client data contains combining accounts, they cannot be imported, but you 
will need to identify them as combining accounts in CSA. For more information about setting up and using 
combining accounts, start the CSA program, then choose CSA Help Topics from the Help menu. Click the 
Index button and choose Combining Accounts Setup. 

Clients with processing periods other than annual, quarterly, monthly, 
or 13 period 
CSA allows you to import clients using annual, quarterly, monthly, or 13-period processing. If you import a 
client that is a semi-annual processor, the import data file should save the balances to the 2nd- and 4th-
quarter balance fields in CSA. You will need to add the client to CSA as a quarterly processor and use 
only the 2nd and 4th quarters for processing. Other processing periods are not acceptable in CSA.  

If you encounter problems during the import 
If you encounter problems during the import to Write-Up CS and cannot reconcile the data using the 
various reports and tools in Creative Solutions Accounting, contact CS Support. 
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CSA help  
For step-by-step procedures, refer to the CSA help. To learn how to use help, choose Help / CSA Help 
Topics, click the Index button, and search on Getting help. 

Website  
If you have questions or need assistance, you can visit our website at CS.ThomsonReuters.com or 
ES.ThomsonReuters.com 24 hours a day for access to our support knowledgebase and for the latest 
information about current issues and processing tips. To take advantage of this convenient means of 
accessing information, choose On the Web from the CSA Help menu, and then choose Product Support 
and Service. 

Support 
To speak with a Product Support Representative, please call CS Support at (800) 968-0600, press 2 for 
Product Support, and then listen to the available options. Normal weekday support is available from 9:00 
a.m. to 8:00 p.m. eastern time. For details on our support hours for other CS Professional Suite 
applications, please visit our website at CS.ThomsonReuters.com or ES.ThomsonReuters.com. 
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